QUICK START

In This Chapter...

Getting to KNOW WINAOWS........cccouiiiiiiiiiiiiiieiiiceeiceeesccereceesseecneeeee s s e snnens 2-2
Installation Of DIFECESOFTO ...........uuuuuunieeieeeeeeeeeeeeeerreeeeeeeeeeeeeeeeeeeeaeeesssassasssssenns 2-3
Getting Started........ccooiiiiiiiiiiie e s s sees 2-8
Welcome to DirectSOFTTOO0 ........oooeveiiiiiiiiieeiieeeeeeeeeieeeeereereeneeeeeeaesseasassssssssssssssssnnns 2-11
Begin Editing @ Program ...........ccccceeiiecimiiiiiiiiiiiiiiceenncreecee s sccneetee e s eianneees 2-13
Establish the Communication LinK..........ccccoouiiiiiiiiiiieiiiireieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeenn 2-23

MoONItOr the Program ..........cccccuviieiiiiiiiiiiiiieiiiieieeeensecreeees s ecsnerteesssssssnnneeees 2-29



- Chapter 2: Quick Start

Getting to Know Windows

System Requirements
DirectSOFT Programming Software runs under 32-bit or 64-bit Windows operating
systems. It’s a good idea to understand the operating system for your computer.

Please check the system requirements when choosing your PC configuration on our web site:
hteps://support.automationdirect.com/downloads.html.

Power Supply

It is recommended that the computer which DirectSOFT operates on has some form of power
surge protection. A quality surge protector will protect your computer from most surges and
spikes; however, an uninterruptible power supply (UPS) will provide the best protection. A
UPS provides isolation between the AC power source and the computer. It also has a battery
backup for blackout and brownout conditions.

DirectSOFT6 Package Contents

Now is the time to review the contents of your DirectSOFT6 software package you should
have the following items:

CD ROM

Programming User Manual
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Chapter 2: Quick Start.

Installation of DirectSOFT6

Step 1: Load the CD

DirectSOFT Programming Software for Direct. OGIC PLC:s is available on the
AutomationDirect CD. To install DirectsSOFTO, insert the AutomationDirect CD into your
PC’s CD drive. Select “Open folder when autoplay dialog appears, or navigate to the CD
drive, and select the SetupDS6 executable.

Step 2: Exit all other Windows Applications

[

General opticns

& » Computer »

DVD Drive (D) DirectSoft6

| Fie Edit View Tools Help

DVD Drive (D:) DirectSofto

Open folder to view files
l using Windaws Explorer

View more AutoPlay options in Control Panel

Name . Date modified Type Size
4 Files Currently on the Disc (1)
I setupDS.e 410/2014201PM  Application Banke

" Network

The dialog below issues a reminder to exit all other Window applications. If you are unsure of
the programs that may be running, open the Task Manager by pressing the Cerl-ALT-Delete
keys at the same time. Close any opened applications by selecting them and clicking on the
Close button of the Task Manager. Click on the OK button to proceed with the installation.

i Before continuing with this Setup program, please be sure to disable any anti-virus software,
and insure that you have Administrator privileges if installing on Windows NT4/2000/%P,
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- Chapter 2: Quick Start

Step 3: Enter the Product Key Code
From this window, enter the Product Key that was e-mailed to you
(or the one who purchased the software), or phone 1-800-633-0405 and get the Product
Key from either sales or technical support if you did not receive it. This software package is
protected by this Product Key code. Only licensed users that have a Product Key code may
install the software. Enter the Product Key using all caps and any dashes shown then click the
Next button.

DirectSOFT 6 - Programming - InstaliShield Wizard ==

Then click on
— the Next button

Step 4: Installing an Upgrade
If you are installing the DirectSOFT upgrade version, setup will search your PC to look for a
previous version of DirectSOFT. If a previous DirectSOFT version is not found, you will be
prompted to enter a valid product key code from a previous version of DirectSOFT.

DirectSOFT 6 - Programming - InstallShield Wizard [

Click here to proceed with
the DirectSOFT6 installation
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Chapter 2: Quick Start.

Step 5: License Agreement
The wizard displays the “Software License Agreement” shown below. Read the agreement
and select I accept the terms of the license agreement. Click Next to continue with the
installation. If you do not accept the license agreement, cancel the installation.

Step 6: Enter the Customer Information

License Agreement

DirectSOFT 6 - Programming - InstallShield Wizard

DiectS0FT 6 License Agreement
IMPORTANT

BEFORE OPENING THIS PACKAGE AND USING THIS SOFTWARE YOU SHOULD
CAREFULLY READ THIS AGREEMENT

The enclosed DirectSOFT 6 compuler softrvare program (the "Software] is the property
of

ine. ot its suppliers. this package, carfuly
read this Agreement.If you da not acoept the temms and condiians of this Agresmen,
you should return the enclosed Saftware and any accompanying tems (inchuding any
manuials, release notes, binders, ete ], unopened, to Automationdirect com for 3 ful
refund

1. LICENSE. Suibject to the terms and condiions of tis Agreement, when you
install this software, Automationdirect eom grants you and you accept a non-exclusive
license to use the folowing you dbizin from. m
The particular Software you have acauired and the type of license is specifisd in your
purchase orde as part of the part nurber for the i, The following appliss to each
type of Software product and ficense:

[ <ok [ hews | | Cancel |

Click here if you agree with the
License Agreement’s terms.

The “Customer Info” window requests the user name and company. Enter the name of the
person assigned to the DirectSOFT Programming Software and the name of your company.
Click the Next button to continue with the DirectSOFT installation.

InstallS!

DirectSOFT 6 - Programming - InstallShield Wizard

<gack || mews

Cancel

==
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Step 7: Select the Type of Installation
The wizard now displays the “Setup Type” window. This window allows you to select either
the “Complete” or the “Custom” type of installation. Complete is the most common selection.
Custom allows you to select the optional components you want. It is recommended that you
select Complete for your DirectSOFT installation. Click on the Next button to proceed with
installation.

Step 8: Ready to Install

DirectSOFT 6 - Programming - InstallShield Wizard ==

Setup Type

InstallS| <Back Heat> Cancel

The wizard continues with the “Ready to Install the Program” window appears. Verify the
folder name where the DirectSOFT files are to be stored. If this is the desired folder, click on
the Next button to continue with the installation.

DirectSOFT 6 - Programming - InstallShield Wizard

ftlls (o] [ caeer ]

2'6 DirectSOFT6 User Manual, 2nd Ed. Rev. B



Chapter 2: Quick Start.

The following window lets you know that the DirectfSOFT6 Programming Software is being
installed onto your computer.

=)

DirectSOFT 6 - Programming - InstallShield Wizard

Step 9: Installation is Complete
The wizard now displays the “InstallShield Wizard Complete” window shown below. Click on
the Finish button.

DirectSOFT 6 - Programming - InstallShield Wizard

If an Upgrade
If an older DirectSOFT version is found during the installation, you will be prompted to
make DirectSOFT6 the default projects folder. You will then be asked if you want the existing
projects copied to the DirectSOFT6 projects folder.
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Getting Started

Before beginning to edit a program, you need to open DirectSOFT. Click on the DirectSOFT6
icon located on your desktop screen to open the DSLaunch window. You can also click on
Start located in the left-hand corner of the computer monitor. Now select Programs, find
DirectSOFT6, then select DSLAUNCHGS in the drop-down window. If your computer is
connected to the Internet, the following DSLaunch window will appear with What’s New.
What's New will have useful information for the user from the AutomationDirect website.

DirectSOFT on
the Web

F DSLaunch )

Fie View Help

8 DircctSOFT on the Webl

[+ Applications
X Direct501 1 b Programming

=¥ Utilties
vt DirectSOFT version 6.1 Is now avallable!
Aisit Host Ingineering S
AHost Forum, FAQs, Downloads.. 3 The latest version of the DirectSOFT Programming Software is now available for purchase on the Automationdirect.com web store. Existing users of DirectSOFT v6.x can
& CTRIO W 2 - Directlogic PLC P |2 Hel-> Check for Updates o dotioadte atst version. Customers with DiectSOFT V6.3 or eafer an putchase an upade tht can be aplie o anypreviots
15 CTRIO WB 2 - EBC + WinPLC. w version of DirectSOFT.
ECTROWB2  PBC
- INEW! support for the new D4-454 CPU with 32K of Ladder Memory, Port 2 supports MODBUS Protocl, and 38400 baud rate for all protocols on all 3 ports
EICTRIO W 2 - Offine INEW! Updated CTRIO Warkbench and ERM Workbench with D4-454 support
B ERM Workbench NEW! Trend Views
W DBWin3? logger NEW! 40+ New |-Boxes
B DNLoader NEW! Box Instruction Leg Labels
SN NEW! Autormatic Check for Updates
e NEW! Faster Status Updates
& IPConfig
A Calculator

5 Windows Network Control Panel
5 Windows Frewall
% Windows Device Manager
@ Windows Services
=B Projects
P di454 drum example chG page 13prj
D dl454 masked event drum instruction cht|
D di4s4 masked cvent drum word outputi
3 dldS4 fault exemplepr

S biesorr ‘Domore!

The latest update to Do-more Designer incudes the Migrate DirectSOFT Project utity that N

utility does NOT work for D3-330, D3-330P or D3-340 projects). We call thi

- this
eiin

aDomore CP s s, courers, shiegte

Al of the

for these elements wil be migrated to the Do-more Designer project s well

The

sessonwnaealDo-moreCPU.

If you haven't already downloaded your free copy of Do-more Designer software, head to htto://support.

html and do so. Did we mention it was free?

03 examples\ep ct 005 205250 ctrio_both |
D di454 pid crample program ché pg 74p)|
13 d454 edrum ché py 1501} .
5 Comm Links TeehTips:

To leam ore about al of the Do-more PLCs and Do-more Designer Programming software go to wiw.do-more. com.

Product Support Forum.

If your computer is not connected to the Internet at the time of launching DérectSOFT, the
DSLaunch window will display a message stating that the website is not available. This is okay.
It isn’t necessary to be on the Internet each time that DSLaunch is opened. Our website can be
accessed anytime the computer is connected to the Internet by double-clicking DirectSOFT
on the Web.
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Chapter 2: Quick Start.

The main DSLaunch window is opened by selecting DirectSOFT6 Programming located in
the Applications section of the Menu Tree. The launch window will then appear as follows.

From this window, additional utilities, such as, NetEdit, CTRIO WB, etc., can all be launched
from one central location. This is also used to create and manage PLC programs and the

communications links between your personal computer and the PLC.

Notice the different areas which are pointed out in the launch window.

D§ DSLaunch

File View Help
% DirectSOFT on the Web
Applications

gl 5] DirectSOFT 6 Programming]
H 4 Utilities
DirectSOFT et

Utilities, such
as NetEdit3

Programming <] Visit Host Engineering
+_] Host Forum, FAQs, Downloads.
~[H] CTRIO WB 2 - DirectLogic PLC,
[ crrio w2 - EBC + WinPL
I .[{f] CTRIO WB2 - PBC
.[Hf] CTRIO WB2 - Offline
[ ERM Workbench

[ Caleulator

Version

1 Ds600.ni

{78 Windows Network Control Panel
{78 Windows Firewall

@ Windows Device Manager
@ Windows Services

(B Projects

&) Comm Links

Dy Address 56

D repair center 5L

ommunication
Links to PLCs

Ready

Windows-type
Menu Tree

[Description: |Automationdirect.com's DL series PLC

rogramming package.

[Version |60 ]

|Additional Info: | [Programming support is installed for:

DirectLogic 05 Series
Installed
Support

DirectLogic 06 Series
Directlogic 105 Series
DirectLogic 205 Series
DirectLogic 305 Series
DirectLogic 405 Series

NOTE: Also see DSLAUNCH comments in Chapter 3.
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- Chapter 2: Quick Start

If you have been using previous versions of DirectSOFT Programming Software, you will see
that the DSLaunch window looks much like it has for many years. Descriptions of the various
sections are as follows:

Applications — These are the applications currently installed in DirectSOFT6. They are
visible in the Menu tree under the Applications folder/icon and are linked to applications
that have been designed for launch from DirectSOFT6. For example, to create a new
program, double-click the DirectSOFT6 Programming name.

Utilities — Several utilities are available under this folder/icon. If you have already installed
available utilities, such as, NetEdit, CTRIO Workbench, etc., these will be shown here.
Shortcuts to your favorite utilities can also be added by adding them to the Utilities section

of the DS600.ini file.

Projects — These are the programs which are created in DirectSOFT6. A project is the
collective name for your program and all of its documentation. When you create a new
project or work on an existing project, you will see it listed in the Menu Tree under the
Projects folder/icon by name. To open an existing project, double-click on the project
name. To open a project not listed, right-click on Projects and select Browse to locate the
project, then select it.

Comm Links — This is for the communication links used to connect from your PC to
one or more of your PLCs. If there were Comm Links existing in your previous version of
DirectSOFT, they will appear here. New Comm Links will also appear here after they are
setup.

The remainder of this chapter will be devoted to the following:

1. Create a new program.

2. Add some rungs.

3. Document the elements and rungs.
4. Connect to a PLC.

5. Download to a PLC.

6.

Monitor the program and change status.
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Chapter 2: Quick Start.

Welcome to DirectSOFT100

NOTE: If you have purchased the full version of DirectSOFT6, go to page 2-14, Begin Editing a Program.

If you have loaded the free version of DirectSOFT6, you should know what you can and
cannot do with the software.

What is DirectSOFT1002
The DirectSOFT100 software is provided as a solution for small applications and to assist in
your decision to purchase the full Direct£SOFT6 programming software. There are, of course,
limitations to the use of DirectSOFT100. The following is what you can and cannot do with
the software:
You CAN create a program from scratch, and it can be as large as you want it to be.

You CAN save programs larger than 100 words to disk, but you CANNOT write it to the PLC.

You CAN convert DirectSOFT100 version to the full version if you purchase the key and
enter the key code in the DirectSOFT100 dialog (it may appear often) or in the Help >
About dialog.

You CANNOT download a program to a PLC larger than 100 words.

You CANNOT open an offline project larger than 100 words.

You CANNOT open a program in the PLC larger than 100 words.

There are no other limitations. DirectSOFT100 is able to use all of the features described in
this manual. Many instances of DirectSOFT100 can be running at one time and monitor any
number of data points. DirectSOFT100 is basically the same, functionally, as DirectSOFT6
(full version) except the ladder program needs to remain within 100 words.

Welcome to DirectSOFT100! =5

i 1 Welcome to the Direct SOFT 100 version of
Fé DirectSOFT & - Programming!

Direct SOFT 100 supports 2 maximum program length of 100 words.
If you create a program longer than 100 words, DirectSOFT100 will allow
you to save it to disk, but you cannot re-open this project with
Direct SOFT100.

“r'ou may purchase a key to unlock the full version by calling us at
1-800-633-0405

Better yet, if pou have access to the Internet, come wvisit us on our web site at
v AutomationDirect. corn

Run DirectSOFT100 | Unlock Full Yersion
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- Chapter 2: Quick Start

Using DirectSOFT100?

To begin a project, double-click on DirectSOFT6 Programming under Applications on the
menu tree. The following Welcome to DirectSOFT100 window will appear.

Click on Run DirectSOFT100 and the New Project dialog will open as shown on page 2-14.

= ( Click here fo begin | =
a project.

% DirectSOFT onthe Web
1 Applications
JZ DirectSOFT 6 Programming

41 Utities
] Visit AutomationDirect
] Visit Host Engineering [Description: |Automationdirect com's DL series PLC

] Host Forum, FAQs, Downloads.

rogramming package
CTRIO WB 2 - DirectLogic PLC

CTRIO WB 2 - EBC + WinPLC [Version: 30 ]
CTRIO W8 2 - PBC
[ CTRIO WE 2.- Offline [Additional Info-_] [Programming support is installed for-
B ERM Workbench DirectLogic 05 Series
DBWin32 Logger DirectLogic 06 Series
DNLoader DirectLogic 105 Series
& NetEdit3 DirectLogic 205 Series
w[d] Calculator DirectLogic 305 Series
Version DirectLogic 405 Series
1 pssg.ini

&l Windows Network Control Panel Welcome to DirectSOFT100!

] Windows Firewall

@ Windows Device Manager =il Welcome to the Direct SOFT 100 version of
@ Windows Services E’E DireciSOFT 6 - Programming!

(8] Projects.

&5l Comm Links Direct SOFT100 supports @ maximum program length of 100 words.
B Address 56 ¥ you create a program longer than 100 words, DirectSOFT100 wil allow

‘youta save t 1o disk, but you cannot re-open this project wih
D, repair center 51 D o

You key o unlack the at
1-800633.0405

Beter yet, it you have aceess to the Intemet, come visit us on our web ste at
i AutomalionDirect com

Run DirectS OFT100 Urlack Full Version

Done NUM

You can now begin to edit a program following from Step 1.
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Chapter 2: Quick Start.

Begin Editing a Program

You can now begin editing your program. The following steps will show you the basics of
editing with DirectSOFT6. This will not be an attempt to teach you how to develop a control
program, but it will give you the basics to get started using DirectSOFTG so that you can edit
a program.

Step 1: Start a New Project

To begin a new project, double-click DirectSOFT6 Programming under Applications in the
menu tree. The following window will appear. The New Project window is used to enter the
basic information to begin a new project. Name the new project, then move the cursor to the
Family area and select the PLC family to match the PLC that you are using. Next, select the
CPU type. Once all of the information has been entered, click on OK. Keep in mind that the
available mnemonics, processing rules and the tool bar characteristics are tailored to the Family
and Type selections that you make.

[ER DirectSOFT 6 Programming [=[@] =]
File View Help

N REPE
Read Disk WriteDisk New  Open  Backup

Cut opy Peste | Find FindNedt Browse

g & =
=
Options

(=)

EditMode Accept

OnTheWeb Help

Read PLC Wiite PLC

Mode  Info  Check .

New Project window

Status  Data  Value  Trend

elect the CPU Type

elect the PLC Family
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After clicking on OK, the next window to appear is the Ladder View with a Tip of the Day
dialog box as seen below. The Tip of the Day dialog will appear each time a new project is
started, and each time an existing project is opened. If it is not desired to have this dialog “pop-
up” as mentioned, simply click off the check mark preceding “Show tips at startup”. The
tips dialog can always be opened by clicking on Help > Tip of the day on the main menu bar.
More tips can be read by clicking on the Next button. After clicking on the Close button the
new Program display window will be totally in view.

B DirectSOFT 6 Programming -Test - [Ladder View] =l =

Fie Edt Seach View Tools PLC Debug Window Help

3:::‘ 'Bj @ = | @) ‘3‘
New Open Backup Options OnTheWeb Help -
.
Data o
XRef View 2 %
@ s &l 2l E ] { nor )
Element Rung_[Address| _nstructior —
NONE
2 { wor )
Tip of the Day =) ,
{ nor )
Did you know.

Show Tips af starfup )| ¥

left/right Y »
CSV text file,

'Y

ata, 3
t the time-stamped data points to a

—\(
¥ stowtpeatsarts e woe )

7 { nor )

. { wor )

= I { woe ) o],
For Help, press FL Offine 00000/02048 [0S

Regular users of DirectSOFT will note that the new programming window looks a bit different
than previous DirectSOFT programming software. The “Online” and “Offline” toolbars have
the same layout as previous DirectSOFT programming windows but a crisp new look for the
button icons. Notice that some of the toolbar icons are grayed-out and some of the icons are
not. The available icons in the online toolbar will be visible. As a program is edited, more of
the grayed-out icons will become visible. The online toolbar is grayed-out and will remain this
way until the PC is connected to the PLC. See Chapter 4 for more toolbar features.
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T ¥ DirectSOFT 6 Programming - Test - [Ladder View] (=] i
Offline T T S TR T
Toolbar N EPQ I & P Ew B @
Read Disk WriteDisk New  Open Backup = Edit Mode Find Browse | Options OnTheWeb Help .
1=
Online s | ]
Toolbar

BE s 8.l <
[ Rung [Address| fhstctior | 1

Cursor

nor )

s { nor )

° ( Ladder Palette Bar )—’—»

7 { nor )

8 noP )

9 { nor )

10 noP )

< , =

For Help, presz FL Offine 00000/02048 05

By default, there are two windows that will be in view when a new project is opened. One is the
Cross Reference View on the left and the other is the Ladder View on the right. The Cross
Reference View is one of the dockable views in DirectSOFT6 which also includes Data Views
and the Output window. These views can be docked to any edge of the Programming Window
or they can be undocked and “float” to any part of the screen, even onto a different display if
you have multiple monitors. If the view is docked, you can “auto-hide” the view by clicking on
the push-pin in the upper right-hand corner of the view. The view will auto-hide to the left of
the Ladder View with the name of the view on the tab. To bring the view from auto-hide, hold
the mouse cursor over the name in the tab. If the view is not needed, click on the X located to
the right of the push-pin to close the view. See Chapter 7 to learn more about views.

Notice the Ladder Palette Bar located to the right of the Ladder View. The element buttons
are grayed-out unless the Edit Mode has been activated. To activate the Ladder Palette, click on
either EDIT Mode button; one is located on the Offline toolbar and one is located at the top
of the Ladder Palette. This palette can be repositioned anywhere on the screen by “grabbing” it
with the mouse pointer at the top of the palette and dragging it to a new position. The Ladder
Palette contains the buttons that access the rung elements and operations commonly used
when editing ladder logic programs.
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The diagram below shows a newly opened Display window with the Cross Reference View in
the auto-hide position and the Ladder View in full view.

[ DirectSOFT 6 Programming - Test - [Ladder View] E‘E&
[ File edit Sesch View Tools PLC Debug Window Help _ex
N B E P Q| o 6% P E - B @
‘Z‘J ] Ladder View| x|y
- Ca Elm.{mg
J = Cross Reference View o)
2 in auto-hide position ——————— )

3 { nop )

4 { nop )

9 { nop )

10 { wor )

|,

For Help presa FL Offine 00000/02028_05

It is good practice to leave the Cross Reference View open while editing your program. The
rung elements are added to the Cross Reference View as the program is accepted.

Accepting a program will be discussed later in this chapter.

NOTE: The Cross Reference View can be retrieved by going to View on the Menu Bar and select it from the
drop-down menu, then click on the push-pin to keep it in view.

Step 2: Select Edit Mode

The ladder View has two viewing modes; the Display Mode and the Edit Mode. When a
new program or an existing program is opened, the Ladder View will be in the Display Mode
which is only a viewing mode. A program cannot be edited in this mode. In order to edit a
program, you must be in the Edit Mode. To enable the Edit Mode, cither click on the Edit
Mode button on the Offline toolbar or click on the Edit Mode button on the Ladder Palette
Bar. You will know when the Edit Mode is active when the cursor box becomes solid, a box
appears around the Edit Mode buttons and the elements in the Ladder Palette are highlighted
(see diagram on the next page).
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5 DirectSOFT 6 Prograrming - Test - (Lodder View] P=rey )
Fle Edt Seh View Toos PC Debug Window Help
N & E P Z > % R (6 R PIE - @
Reod Dk WikeDik New  Open Sockop adcet | Gt Coy past | Fnd FindNew Srowse | Optons OnThewes hep -
@ = B 7
AR View 311 | ] Ladder view| K a7
EEE 2] ol | @l
= [ Rung [Address ior 1 - ¢ wor ) gsdnlﬂfd,
ToNE [ \
. o ) ”‘
"
3 Ea|t Nﬂoae e — L) “
. 5
. (solid cursor box) ¢ wor ) "
- Ctrl+F2
5 { nop ) EE1d
s ||
s { nor ) AIk
siter2
' Rl |
s { wor ) 1=
9 { nop ) M
© { wor ) =
o 5 =N
|For Help, press F1 Offline 100000/02048 05 )|

The Ladder Palette (shown below) may not be exactly like the one you have on your computer
screen. The elements shown in the palette will depend on which CPU your PLC is using. This
example shows the elements common to most of the CPUs.

Normally Closed Normally Closed
Contact Immediate Contact
Negative
Differential
Accept Normally Open | positive ~ COMact
. Normally Open Immediate Differential Equal to
Edit Mode Contact Contact Contact Contact

Ladder Palette Bar

Al SRR R M e

Edit Mode | Accept F2 = Ctrl+F2  Ctrl+F3 | Shift+F2  Shift+F3

= 2 <k PP O 8 x F
f ! f) Contacts  Coils Boxes Browse S AW
' !
Not Equal to Less Than Contact )
Contact Browse Coils Wire to Output
Equal to/or t Browse .
Greater Than Browse Contacts Boxes Wrap Wire to
Contact Stage

Browse Elements
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Step 3: Enter an Input Element
Use the Ladder Palette to enter the first instruction of the program. First, click on one of the
Edit Mode buttons to begin to edit your program. The rectangular edit cursor will change to a
solid color. The edit cursor should be positioned to the far left on Rung 1. Your first entry can
be placed here, normally a relay contact or an element. Click on the Normally Open Contact
symbol on the palette.

The cursor will change to a box with an open relay contact, a window with the text cursor

blinking at the end of address CO (highlighted) and green, valid entry, indicators.

Delete Open the
Enter the edit box Element Browser
contact

| R ]

™~ Valid entry

4_
Default ___ 1> indicators
address — —

If the green dot changes to red, it means that the address is incorrect, not valid or a wrong
character. For example, if you typed the letter “O” instead of the digit “0”, the indicator
would turn red and stay red until you correct the mistake. For this example, enter X0 over CO.
The valid entry indicator should be green meaning the address is correct. Continue by either
clicking on the check mark () or pressing the Enter key.

7] Ladder View

e
K | Note: The Valid entry

y
(Enter X )/) S indicator will be green
when a valid contact

address is entered

2
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Chapter 2: Quick Start.

The element will be entered and the cursor will move to the next entry position. A yellow

vertical bar will appear to the left of Rung 1. The yellow bar indicates that an instruction (or
instructions) has been entered, but the program has not been accepted (compiled).

|E% DirectSOFT 6 Programming - Test - [Ladder View]
E &) ]

File Edit Search View Tools PLC Debug Window Help

*REPpQd e

Read Disk Write Disk N Open  Backup |Edi

Data n o

6

2 E

Find Browse

Optio

XRef View 21X | ] Ladder View|

Em [s sluldr] 2l - B
Element [ Rung |Address| _Instructior PR Sy
MNONE \ = 1

ES

Yellow
colored bar
indicates the
rung has not

been accepted.

A

Step 4: Enter an Output Element

Now, move the cursor to the end of the rung, positioned over the NOP. Click on the Browse
Coils button on the Ladder Palette. The Instruction Browser will appear with the Standard
Coil selected as the default. Click OK to enter the standard coil. Keep in mind that one of the

other output coils could have been selected.

DirectSOFT6 User Manual, 2nd Ed.
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- Chapter 2: Quick Start

The Instruction Browser will be replaced with the element entry box. The default
address, CO, will be highlighted. Enter YO and notice the valid entry indicator is green
for a proper entry. Either click on the () or press the Enter key to enter the output coil.

ol Py 2]

Enter YO here

ouT

Rung 1 has now been programmed. This rung can be downloaded to the PLC except for one

missing rung. All programs must be terminated with an END Coil rung.

PE_ DirectSOFT 6 Pragramming - Test - [Ladder View] = | B
File Edit Sesrch View Tools PLC Debug Window Help
N REPe d 2 g 2 P o B
ReadDisk WriteDisk New  Open Backup |EditMode| Accept Find Browse | Options OnThe Web -
3]
Data -
XRef View B | Ladder View| 4k x @f
/
By 2L . —=A
Element | Rung [Address| Instructior 1 =} { our ) o
NONE (f
Accept
2 { nop )
: 1t
2}
3 { nop ) P
2]
4 { nop ) 11+
Step 5: Enter the End Rung
To program this rung, position the cursor over the NOP  fiamsom ==

at the end of Rung 2, and click on the Browse Coils
button. The Instruction Browser will appear as shown in
the diagram below. This time, select Program Control
located in the Coil Class selection window. Next, select
END located in the Coils selection window. Click on OK,
then Enter.
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Chapter 2: Quick Start.

The below diagram shows the two rungs that have been programmed. This is a basic program
that can be downloaded to your PLC. Additional rungs can be programmed, but you can go
ahead and accept the program.

7. DirectSOFT 6 Programming - Test - [Ladder View] | E=HEER =)
file Edit Search View Tools PLC Debug Window Help
= =1 (=N = = P = »
N EPY Q| W e P IE . B
Read Disk WriteDisk New  Open Backup |Edit Mode | Accept Find Browse | Options OnTheWeb -
1= S
e 8 i Accept
XRef View A1 | ] Ladder View| hu"ons v x|y éf
EIW_I_I_I_IEQ" %‘ X0 N— Yo ﬂﬁﬁﬁd
Element Rung_|Address| Instructior =N { our —
NONE . ¢
Accept
2 { eno )
1t
i _— R
Il 3 —{ nor )
I = |+
=]
¢ { o ) {1t
CtleF2
5 { nor ) 7
CtieF3
6 { nop ) 41k
i Shift-F2

Step 6: Accepting and Saving the Program

The program now needs to be accepted in order to be downloaded to the PLC. As noted in the
above diagram, there are two Accept buttons. Click on either Accept button to compile the
program. Once the rungs are accepted with no errors, the yellow bar will change to green, the
Accept buttons will be grayed-out and the Cross Reference View now shows the two elements
that have been programmed.

Read and
Write buttons

[ DirectSOFT 6 Programming €2 - [Ladder View] [E=EER)
File Edit sEmw Tools PLC Debug Window Help
R >137@. BB PLIE - D@
Read Disk Write Disk New  Open Backup | Edit Mode Find Browse | Options OnTheWeb Help -
- 1= £ =
XRef View BIx] | ] Ladder View| i =
EMW—I—I—I—IE' 2l E‘ X0 Yo ﬂ‘{d%ﬂe
Element Rung [Address| Instruct ~ 1=} { our )
"1 [ 0 [EEsRI
Y0 1 [ 1 [Eour -«
: Green bar indicates | ¢ *° ) i
s the rung has been ¢ vor ) w
| accepted. =
4 | { nop ) Ik
Programmed | cuer2
elements now : € noe ) T
appear in the Cross \ ¢ ) o
Reference View iz
7 Ceo R
o sl s T S |
For Help, press F1 _ Offline _ym 05 [ _
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- Chapter 2: Quick Start

Notice that the two Read and Write buttons located to the left of the Offline toolbar are
enabled and no longer grayed-out. The program can now be saved to the PC’s disk. To write
the program to disk, click on the Write button. It is not necessary to save the program in
order to download the program to the PLC, however, it is good practice to save your work
as you edit a program. A mistake may be made at times and you may want to restore the
program to a previous state prior to the mistake. If a mistake is made and you want to restore
the program, click on the Read button. This will refresh the screen with the previously saved
version of your program.

NOTE: When the program is saved by clicking on Write (only to disk), the ladder program is all that is

saved. Once you have edited a program and have included total documentation, you will want to save
all that you have done. This is accomplished by selecting File > Save Project > to disk. You can also
click on Backup to accomplish the same thing with the addition of a Backup file. For more detail about
documenting and saving the project refer to Chapter 6.
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Chapter 2: Quick Start.

Establish the Communication Link

In order to download a program to the PLC a communication link must be established. This
section will step you through the procedure for setting up the serial port of your PC. Refer to
Chapter 9 if you need to create a serial link for a modem, or an Ethernet link. The following
procedure will step you through the process of connecting the example program to a PLC.

Connect the PC to the PLC
Connect the programming cable from the serial port of the PC to the serial port of the
PLC. Turn on your PLC and be sure that the RUN\TERM\STOP switch on the PLC is in
the TERM position. Now, click on PLC on the Menu Bar, then select Connect from the
drop-down menu and the Select Link dialog will appear. Since there isn’t a link to chose,

click on Add.

g B!

Select Link...

— Lirk:

Select

Cancel

g

add.. |

Edit...

il

Delete

[ Link Enabled Help

Step 1: Select the Port
The following Link Wizard dialog will appear showing a list of communication ports. Select
the port you will use (commonly COM1) and click Next.

DirectSOFT6 will automatically find any communications ports that are shown in the
Windows Device Manager. If a port is not shown please close all DirectSOFT6 windows and
restart the program.

- .
Link Wizard [

Select the communications port that the PLC is connected to.

Mordem support cannot be canfigured from the Link Wizard
To select modem support, you must use the manual
configuration dialog by selecting "Link Editor.." below

Ports:

Link Editor <ok [ Wews | camcel |
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Step 2: Select the PLC

The next window will show a list of PLC Families. Select the PLC family by clicking on the
appropriate choice. If you are unsure of the PLC family but know which communications
protocol to use, select “Not Sure”. If you are using a DirectLOGIC compatible PLC, the
Link Wizard will try and detect the PLC type automatically. Click Next when you are finished.

. -
Link Wizard =5

Selact the PLT product family of the FLE you wish to connect
to.

If you are unsure, but know the communisations protacol it
uses, select " Not Sure' from the st

PLC Famiies

Direct Logic 305
Direct Logic 3085

DL 0142744350 Family
Link Editor... < Back I Mext > I Cancel

‘E NOTE: DL 0/1/2/4/350 should be selected for the following PLC families: DL05, DLO6, DL105, DL205,
D3-350 and DL405.

Step 3: Choose the Protocol and Node Address

In this step, you will see a choice of either DirecsNET or K-Sequence. Assuming you have
selected the Directl.OGIC PLC family (not the DL305), the default, K-Sequence, will
be highlighted. The K-Sequence protocol
allows you to perform write operations to
individual discrete I/O points and control
relays. DireceNET protocol cannot write to
individual bit locations. (See Appendix A for
a list of protocols available for DirectLOGIC |
and compatible PLCs).

- 5
Link Wizard ===

Select the protocal to use in the communications link.

If you selected a PLC family, a valid potocal has been

DirectNER EEZEEN

Uireg IF the selected pratocol suppans node addiessing, enfer the

station address. |f pou are unsure, leave the default.

Protocals
DirecthET

pddess[T 4]
If your PLC has been configured with a node
address other than 1, enter that address now.
Click Next when finished.
Link Editor <Back [ New> | Cancel
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Chapter 2: Quick Start.

Step 4: Name the Link

If the Link Wizard is successful in communicating with the PLC, the following window
will prompt you to enter a unique link name, and a description of the link if desired. The
description field allows 32 characters. Enter the name for the link and description then click
Finish and the Select Link dialog will appear with the link name listed.

Link Wizard [

Link zettings complete!

Please select a unique name for the new link.

. __I-I-—- Lirk Name: IDSCBL 0 -

Link Description: ISeriaI

Setting:
P 06 Port [ COM1
Pratocal | K Sequence Baud: | 3600
Address: | 1 Paiity: | Odd

Link Editar... | < Back I Finish I Cancel

Since the link that was just created is the only one named in the dialog, click on Select to
initiate connecting to the PLC.

-
Select Link...

Select

it g

Cancel

Add...

Edi...

Delete

i

[¥ Link Enabled Help

DirectSOFT6 User Manual, 2nd Ed. Rev. B I 2 25



- Chapter 2: Quick Start

DirectSOFT6 automatically compares the currently open program with the program stored in
the PLC. The following Online/Offline Differences dialog box will appear. This dialog asks
which copy of the ladder logic program is to be viewed, the copy in the PLC or the copy on

Cnline/Cffline Differences @

There are differences between the anline and offine programs.

Select source of program to view.

MOTE: This operation only loads the selected program into memary. It
does NOT overwrite the program not selected. Ta write the
prograrm, select \Write Program or Save Project and specify the
desired destination.

Use PLC UseDisk | Derale. | Comeal |

L

the PC. Since we are dealing with a new program, select the Use Disk button. The Use Disk
button is used whenever you have made a change to a program in the PC, and you are going
online to load it into the PLC. If the Details button is pressed, a side-by-side comparison
of the program in the PLC and the program on the PC will appear, such as the Compare
Programs dialog seen below. The program selection can also be made from this dialog.

Compare Programs

Use Disk

FLC | Diisk - Close
ngram Length: il !Proqram Length: 4 1
0 STR CO 0STR %0 Help
10UT C1 10UT Yo Q
2 5TR =1 Copy To Dutput
3 0R C10
4 ANDM =2 Use PLC
5 QUT C10

< :

Program sizes different!

2'26 I DirectSOFT6 User Manual, 2nd Ed. Rev. B



Chapter 2: Quick Start.

After clicking on the Use Dis

k button, the programming window will look a bit different.

Notice that the icon buttons in the Online Toolbar are no longer grayed-out. The indicators
at the bottom of the window tell you that the PLC is okay, the PC is online with the PLC and

the PLC is in Program Mode.

At this point the program has not been written to the PLC.

You will also notice the two left most buttons on the Online toolbar (Read PLC and Write
PLC) are highlighted. To write the program to the PLC, select Write PLC. A pop-up indicator
will appear to let you know that the program is being written to the PLC.

'E:ch:tﬁ()ﬁﬁ Programming - test - [Ladder View] =8 ﬂ‘
File Edt Search View Tools PLC Debug Window Help
= oo 15 . = .
E P e @R P Huw D@
New  Open Backup |Edit Mode Find Browse | Options OnTheWeb Help -
TEwy BOR
RezdPLC WritePLC | Status Data  Value Trend = Mode Info  Check -
XRef View JLIES| Ewaermemd ar x|
EE s Blold| 0 w E‘mm
Elemen\_ [ Rung [Address| Instruci ~ 1 =Kk { our
X0\ 1+ [ 0o [EdsmrlI
Yo\ [+ [ 1 |&out
2 { eno )
, Click on the Mode | EP—
button to change the —
Write PLC buttons . PLC mode e )
5 { nop )
W
6 { nop ) I
7 { nop ) f
8 { wnop )
9 { nop )
10 { nop ) I
0= , . P
For Help, press FL oK Online DSCBL 06 Progan __[00003/07680 06 [0003:001:0UT l

After the program has been written to the PLC, all that needs to be done is to place the PLC
in the RUN Mode. Click on the Mode button on the Online toolbar. This will bring the PLC
Modes dialog window into view. Click on Run, then OK and the PLC will be in the RUN

Mode.

PLC Modes

=)

Current PLC Mode: PROGRAM
Mew PLC Mode: & Run

" Program
O Test

Help

0K | Cancel
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Notice the green indicator at the bottom of the Ladder View. It shows the PLC is now in
the Run Mode. How do you know that your program works? The best way is to monitor the
program while the PLC is online.

[, DirectSOFT 6 Programming - test - [Ladder View] =lE
File Edit Search View Tools PLC Debug Window Help
[= | SRS RPN — 5 r = -
B EBEPpa e 6 P Ee B @
New  Open Backup | EditMode Find Browse | Options OnTheWeb Help -
[ B o y E
Status  Dats  Value Trend | Mode Info  Check -
XRef View #x] | ] Ladder View|
BEF a1 ol .
Element Rung_[Address| _Instruct ~ g =y {
1T [ 0 |Edsml]
Yo [+ 1 [etour
2 { e )
] 1
El { nop )
4 { nop )
5 { nop )
I
6 { nop ) f
7 { nop ) |
i
8 { nop )
9 { nop ) i
0 { nop )
. . A,
For Help, press FL 4

reen indicating
Run Mode
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Monitor the Program

There are many things that can be monitored in the relay ladder program by simply clicking
on the Status button on the online toolbar. The monitor mode can be turned On and Off by
clicking on the status button. When in the status mode, the element background will change to
blue (by default) to indicate power flow when the input element is turned on. If there is power
flow, the output background will also change color.

[E% DirectSOFT 6 Programming - test - [Ladder View] =HAC Q
File Edit Search View Tools PLC Debug Window Help
Fre) ST —p . = -
E P e ¢ L) P E . B @
New  Open Backup = Edit Mode Find Browse | Options OnTheWeb Help -
|8 ey B O
Status | Data  Value Trend = Mode Info
ARef View ]| FF]Ladder View|
BEls a1 2 0 0
Element [ Rung [Address| nstruct - N | { our
X0 |+ [ o [EAsRlI
Y0 |+ [ 1 [=tout
2 { e )
3 S ——
Background color to nor )
\ indicate power flow | |
e —— Ve
(1/0 On). i
5 { nop )
6 { noe ) I
7 { nop )
8 { nop )
9 { nop )
" { nop ) I
. - I
eh ™| B =],
For Help, press FL 0K Oniine-DSCBL 06 [IIRGANIIN (00003/07680 (06 0004:001:0UT

The program editing and testing is now complete. The example program is the most simple
program that can be written. You can add to this program by inserting rungs before the END
rung (Rung 2) or by deleting the END rung and continuing to edit additional rungs. Do not
forget to end your program with an END rung.
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The following graphic is an example of how you might continue with your program. Note the
Cross Reference View and the Data View panels on the left. Chapters 9 and 10 will explain
how to use these views.

VB:DwedSOFI'E Programming - test - [Ladder View] ) (=R ﬂ‘
File Edit Search View Tools PLC Debug Window Help
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